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Introduction

VCS database agents monitor specific resources within an enterprise
application, determine the status of these resources, and start or stop them
according to external events. The VCS database agent for Oracle provides high
availability for Oracle in a VCS cluster.

About the VCS database agent for Oracle

The VCS database agent for Oracle monitors the Oracle database and listener
services, brings them online, and takes them offline.

The package contains two VCS agents:
m  The Oracle agent, which monitors the Oracle database services.

m  The Netlsnr agent, which monitors the listener services.

Both agents work together to provide high availability for Oracle.
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About the VCS database agent for Oracle

Oracle agent

Netlsnr agent

The Oracle agent monitors the database processes. The agent brings the Oracle
database services online, monitors their status, and takes them offline. Specific
agent operations include:

Online—Starts the Oracle service.

Offline—Stops the Oracle service. The operation also stops all the services
that are dependent on the Oracle service.

Monitor—Verifies the status of Oracle services. The agent provides two
levels of application monitoring: basic and detail.

m  Basic monitoring: The agent queries the Service Control Manager
(SCM) to verify that Oracle services are continuously active.

m  Detail monitoring: The agent runs a SQL script to verify the status of
the database. Detail monitoring is optional. It updates a temporary
table in the Oracle database to verify the availability of the database
instance. See “Configuring detail monitoring” on page 59 for
instructions on configuring detail monitoring for an Oracle database.

Clean—Forcibly stops the Oracle database.

Info—Provides static and dynamic information about the state of the
database. See “Info entry point” on page 11 for more information.

Action—Performs predefined actions on a resource. See “Action entry point”
on page 12 for more information.

The Netlsnr agent monitors the listener process. The agent controls the listener
for the database. The listener is a server process that listens to incoming client
connection requests and manages traffic to the database.

The Netlsnr agent brings the listener services online, monitors their status, and
takes them offline. Specific agent operations include:

Online—Starts the listener service.
Offline—Stops the listener service.
Monitor—Queries the SCM for the status of the listener service.

Clean—Forcibly stops the listener service.
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Info entry point

The Info entry point provides static and dynamic information about the state of
the database.

The entry point retrieves the following static information:

Version InstanceNo InstanceName
HostName StartupTime Parallel
Thread InstanceRole

The entry point retrieves the following dynamic information:

InstanceStatus Logins DatabaseStatus

ShutdownPending

You can add additional attributes by adding sqgl statements to the file
%VCS_HOME%\bin\Oracle\scripts\info\db_info.sqgl. For example:

select 'static:HostName:'\\host_name from v$instance;
select 'dynamic:ShutdownPending:'||shutdown_pending from
v$instance;

The format of the selected record must be as follows:
attribute_ type:userkey_name:userkey_value

The variable attribute_type can take the value static and/or dynamic.
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Action entry point

Action entry point

The Action entry point enables you to perform predefined actions on a resource.

To perform an action on a resource, type the following command:
C:\> hares -action <res> <token> [-actionargs <argl> ...] [-sys
<system>] [-clus <cluster>]

Table 1-1 includes the actions that the agent supports.

Table 1-1 Actions supported by Oracle agent
Token for Action Description
VRTS_GetInstanceName Retrieves the name of the configured instance.

VRTS_GetRunningServices Retrieves the list of processes monitored by the agent.

DBRestrict Changes the database session to enable the RESTRICTED
mode.

DBUndoRestrict Changes the database session to disable the RESTRICTED
mode.

DBSuspend Suspends a database.

DBResume Resumes a suspended database.

DBTbspBackup Backs up a tablespace; actionargs contains name of

the tablespace to be backed up.

You can also add custom actions for the agent. For further information, refer to
the Veritas Cluster Server Agent Developer’s Guide.
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Supported version and operating system

Oracle 9i, Release 2 (9.2.0.2) Standard Edition or Enterprise Edition

or

Oracle 10g, Release 1 (10.1.0.2) Standard Edition or Enterprise Edition
with

Windows 2000 Server, Advanced Server, or Datacenter Server (all require
Service Pack 4 with Update Rollup1)

or

Windows Server 2003 (Standard Edition, Enterprise Edition, or Datacenter
Edition) (SP 1 supported, but not required for all editions)

Storage Foundation HA 5.0 for Windows (SFW HA) with the Veritas Cluster
Server Database Agent for Oracle

Note: SFW HA support for Oracle is limited to 32-bit versions of the operating
system.

How the agent makes Oracle highly available

In the basic monitoring mode, the database agent for Oracle detects a failure if

the database or a listener service is not running. In the detail monitoring mode,

the agent detects failure if a preconfigured SQL script cannot execute or access
the database or if the listener service is not running.

When the agent detects a failure, the Oracle service group switches to the next
available system listed in the service group’s SystemList attribute. VCS starts
the configured Oracle and listener services on the new system, thus ensuring
high availability for the Oracle services and data.

13
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Typical Oracle configuration in a VCS cluster

Typical Oracle configuration in a VCS cluster

In a typical configuration, VCS is configured in a two-node cluster (System 1 and
System 2). Oracle is installed on both systems, and the data to be used by Oracle
is installed on shared storage. The Oracle database agent is installed on both
systems.

Figure 1-1 Typical Oracle configuration in a VCS cluster
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Setting up an Oracle cluster

Setting up an Oracle cluster in a VCS environment involves the following tasks.

m  Setting up a VCS cluster. See the Veritas Cluster Server Administrator’s
Guide for more information.

m Installing and configuring Oracle. See “Installing and configuring Oracle”
on page 17.

m Installing the Oracle agent. See “Installing the Oracle agent” on page 41.

m Configuring the Oracle service group. See “Configuring the Oracle service
group” on page 43.
Each task is described in detail in subsequent chapters.
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Installing and configuring
Oracle

This chapter describes how to install and configure Oracle and its components
in a VCS cluster. For specific instructions on how to install Oracle, see the Oracle
documentation.

Prerequisites

m  Verify all nodes have adequate resources to run Oracle and SFW HA 5.0.

m  Verify that SFW HA is installed on all nodes in the cluster. Refer to the
Storage Foundation and High Availability Solutions, Installation and
Upgrade Guide for installation steps.

m  Verify you have run the VCS Configuration Wizard (VCW) to configure VCS
on all nodes. Refer to the Veritas Cluster Server Administrator’s Guide for
configuration instructions.

m  Verify the network and the systems support the TCP/IP protocol.

m Create volumes on the shared cluster disk groups before installing Oracle.
See “Managing storage using SFW” on page 18 for instructions.

m  Logon as domain administrator to install Oracle binaries.

Note: After creating the database, you must log on to Oracle with database
administrator privileges and complete the installation procedure on all nodes in
the cluster.
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Managing storage using SFW

Storage Foundation for Windows (SFW) manages data by creating disk groups
from physical disks. These disk groups are further divided into volumes, which
can be mounted from the cluster nodes.

Symantec recommends creating three volumes on shared disks, one each for the
following:

m database files
m control files

m log files, including the redo logs and archive logs

Perform the following tasks to create volumes and make them accessible from
cluster nodes:

m  Create disk groups. See “Creating disk groups” on page 18.
m  Create volumes on disk groups. See “Creating volumes” on page 20.

m  Mount volumes. See “Mounting volumes” on page 25.

Creating disk groups

This section describes how to create disk groups.

To create a disk group

1 Openthe VEA console by clicking Start > All Programs > Symantec > Veritas
Storage Foundation > Veritas Enterprise Administrator and select a profile
if prompted.

2 Click Connect to a Host or Domain.

3 Inthe Connect dialog box, select the host name from the pull-down menu
and click Connect.

To connect to the local system, select localhost. Provide the user name,
password, and domain if prompted.

4  To start the New Dynamic Disk Group wizard, expand the tree view under
the host node, right click the Disk Groups icon, and select New Dynamic Disk
Group from the context menu.

5 Inthe Welcome screen of the New Dynamic Disk Group wizard, click Next.
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Specify the information related to the disk group and click Next.

localhost - New Dynamic Disk Group Wizard

New Dynamic Disk Group Wizard

Enter a unique name for this dynamic disk group, and then select the disks to include.

Group name:[DG1L

¥ Create cluster groug
[ Create Windows Disk Management compatible group
[ Acd private group protection

Avalable disks: srted disks:
& Harddisk!

S Harddike adds
Srradds Add All>>
58 Harddisks d

S Harddisks Remove
S8 Harddisk?

S Harddisks <<Rgmove Al
53 Harddiska

S Harddisk1o

53 Harddiskt 1

[ Disk name(s)prefix:

< Back Cancel Help

Group name Type a unique name for the disk group.
Create cluster group Check this option.
Available disks Select the disks to include in the disk group and Add. The

selected disks appear in the Selected disks box.
Optionally, check the Disk names prefix check box and
enter a disk name prefix to give the disks in the disk
group a specific identifier. For example, entering
TestGroup as the prefix for a disk group that contains
three disks creates TestGroupl, TestGroup2, and
TestGroup3 as internal names for the disks in the disk
group.

Click Next to accept the confirmation screen with the selected disks.

Click Finish to create the new disk group..

The newly created disk group is imported on the system where you ran the
wizard.

19
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Creating volumes

This section describes how to create dynamic volumes.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator
and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 Inthe Connect dialog box select the host name from the pull-down menu
and click Connect.
To connect to the local system, select localhost. Provide the user name,
password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node
to display all the disk groups. Right click a disk group and select New
Volume from the context menu.

5 At the New Volume wizard opening screen, click Next.

6 Inthe Assign Disks for Volume panel, assign disks to the volume, and then
click Next. Make sure the appropriate disk group name appears in the Group
name drop-down list.

localhast - New ¥olume Wizard [ x]
Assign Disks for Yolume *
Storage Foundation wil automatically select the disks used to create the volume unless you choose to manually specify any of the @
disks to be used,
Group name: |DE1 -
* Auto select disks
€ Manually select disks
Available disks: Selected disks:
Harne PETL Size: | fdd
5 Harddisks P1COT4LO 8,500 GB
Add Al
<Remove
<<Remave All
[ Disable Track Alignment
= Back. Cancel Help
Group name From the drop-down list, select the disk group on

which to create a volume.

Auto select disks Automatic disk selection is the default setting.
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Manually select disks To manually select the disks, click this option
and use the Add and Remove buttons to move the
appropriate disks to the Selected disks list.
Manual selection of disks is recommended.

Disable Track Alignment You may check Disable Track Alignment check

box to disable track alignment for the volume.
Disabling Track Alignment means that the
volume does not store blocks of data in alignment
with the boundaries of the physical track of the
disk.

Specify the attributes for the volume and click Next.

localhost - New Yolume Wizard

New Yolume Wizard

Select the attributes for this volume,

Yolume name: [DATAL_VOL
Sige: 500 MB = | MaxSie

Layout

% Concatenated  Colurs:

" Striped Stripe unit size

 RAID-S | Strige acrass; Fort - = irar across: [eort =

Mirror Info

[ pirored

IZ_j: Total mirrars: |2_:|
(sectors): [128

I Engble logaing

of data an one or more disks.

Concatenated: A simple volume with a single copy

<gack [ meds | cancel | e |

Volume name

Size

Layout

Type a name for the volume. The name is limited to 18 ASCII
characters and cannot contain spaces or forward or backward
slashes.

Specify the size for the volume.

If you click on the Max Size button, a size appears in the Size
box that represents the maximum possible volume size for
that layout in the dynamic disk group.

Allow the default Concatenated layout or specify the layout
preferences for the volume, if applicable. To select mirrored
striped, click both the Mirrored checkbox and the Striped
radio button.

If you are creating a striped volume, the Columns and Stripe
unit size boxes need to have entries. Defaults are provided.



22

Installing and configuring Oracle

Managing storage using SFW

Mirror Info Specify the mirror information for the volume, if applicable.

In the Add Drive Letter and Path dialog box, assign a drive letter or mount
point to the volume and then click Next.

localhost - New Yolume Wizard

Add Drive Letter and Path
You can assign a drive letter to this valume.

& Assign a drive letter: [l =

" Do not assign a drivs letter

An NTFS mount peint can not be assigned if the host is remote.

€ Mount as an empty NTFS foldsr: Broyse

<geck [[ mext> | concel | mep |

Assign a drive letter

Mount as an empty
NTFS folder

To assign a drive letter, select this option, and from the
drop-down list select the drive letter to be assigned.
Verify the availability of the drive letter on all the systems
before assigning it. You must use the same drive letter or
mount point on all the systems in the cluster.

To mount the volume as a folder, select this option, and
click Browse to locate an empty folder on the shared disk.
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Create a file system on the new volume and then click Next.

localhost - New Yolume Wizard

Create File System

size.

[ Format this volume

~Select a fils system:

‘fou can format this volume with a specific file system, label, compression method and allocation size,

Choosing the optian "Defaul” wil alow the pragram ko provide optimal values For the allocation unit i

FAT
FAT3Z
MTFS

~File system options:

Allocation size:
File system label:

v Bafform 2. quick formnat

[~ Enable file and folder compression

DATA1_VOL

MTFS: minimum volume size is 3,000 ME

v

<gack [ W | conced | help |

Format this volume
Select a file system

Allocation size

File system label

Perform a quick format

Enable file or folder
compression

Check this option, if not already checked.
Click NTFS.

From the drop-down list select an
allocation size or accept the default.

Type a label for the volume. This is
optional. SFW makes the volume name
the file system label.

Select Perform a quick format if you
want to save time.

Select this option to save disk space. Note
that compression consumes system
resources and performs encryption and
decryption, which may result in reduced
system performance.

Review the information in the Summary panel and click Finish to create the

new volume.

Repeat step 1 through step 10 for all the volumes to be created.
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Installing and configuring Oracle

The strategy for installing Oracle into a VCS cluster is aimed at ensuring that
installations on all cluster systems are uniform. This involves installing the
Oracle binaries locally on each system and installing the Oracle control files,
datafiles, and log files, and the flash recovery area on shared storage.

Note: Before installing Oracle, create volumes on shared disks. Symantec
recommends at least three volumes on shared disks, one each for control files,
log files, and database files. See “Creating volumes” on page 20.

Overview of tasks

You must perform these tasks on each node that will host the Oracle service
group.

Mount volumes for the Oracle installation. See “Mounting volumes” on
page 25.

Install Oracle binaries. See “Installing Oracle” on page 26.

Create the database on shared disks. See “Creating the database on shared
disks” on page 28.

Create a virtual IP address for the databases and the listeners. See “Creating
a virtual IP address” on page 30.

Create the listener service. See “Creating the listener service” on page 30.

Configure the listeners to use the virtual IP address. See “Configuring the
listeners to use the virtual IP address” on page 30.

Associate the database with the listener service. See “Associating the
database with the listener” on page 31.

Configure the database. See “Configuring the databases” on page 32.

Configure the listeners to use the same virtual IP address. See “Configuring
the listeners to use the virtual IP address” on page 30.

Make sure that the Oracle registry points to the correct location of the
initialization parameter file. See “Verifying the initialization file settings”
on page 37.

Unmount the volumes. See “Unmounting the volumes” on page 39.

Delete the virtual IP address. See “Removing the virtual IP address” on
page 39.
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Mounting volumes

Mounting a volume involves importing the disk group and assigning a drive
letter or the folder path. Unmounting a volume involves removing the drive
letter or the folder path and deporting the disk group.

To mount a volume

1

Open the Veritas Enterprise Administrator. Click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator.

If the disk group is not imported, import it. From the VEA console’s tree
view, right-click the disk group and select Import Dynamic Group from the
context menu.

Right-click the volume, and then click File System > Change Drive Letter
and Path.

In the Drive Letter and Paths dialog box, click Add.

In the Assign Drive Letter panel, choose one of the following options
depending on whether you want to assign a drive letter to the volume or
mount it as a folder, and click OK.

m  To assign a drive letter
Select Assign a Drive Letter and select a drive letter from the
drop-down list.

m  Tomount the volume as a folder
Select Mount as an empty NTFS folder and click Browse to locate an
empty folder on the shared disk.
You must ensure that you use the same disk on all the nodes. To identify a
disk, run vingetdrive -details from the command prompt on one
node. Note the disk number and signature of the disk. Rerun the command
on the second node and identify the disk that has the same signature as the
one on the first node. Once you have identified two identical disks, assign
the same drive letter to the volumes on each disk.

Repeat step 3 through step 5 for all the volumes to be mounted.
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Installing Oracle

Install Oracle from the Oracle software disc. The installer screens and options
may vary slightly for different versions of Oracle.

Install the Oracle program files on a local disk and the Oracle data files on
shared storage managed using SFW. Install all log files, including redo logs and
archive logs, on the same volume.

Specify the same parameters on all nodes. For example, the database name, file
locations, database credentials, must be the same on all nodes.

To install Oracle

1

Verify the shared drives created to store Oracle data are mounted on the
node where you run the wizard. See “Mounting volumes” on page 25.

Insert the Oracle software disc in a drive connected to the node and run the
Setup program.

From the browser menu, click Install/Deinstall Products.
Read the information in the Welcome panel and click Next.

Complete the following instructions depending on the version of Oracle:

For Oracle 9i

m In the File Locations dialog box, type or select a name and a path on the
local disk, for the Oracle Home, and click Next.

m  This will install the Oracle binaries on the local disk. Use the same
Oracle_Home name and path on all nodes.

m In the Available Products panel, select the Oracle 9i Database option
and click Next.

m IntheInstallation Types panel, select the Enterprise Edition option and
click Next.

m Inthe Database Configuration panel, select the Customized or
Software Only option and click Next. Select the Customized option if
you want to migrate earlier databases to Oracle 9i.

m If you chose the Customized option, then on the Database
Identification panel, select or type a unique name and SID for the
global database and click Next.

For Oracle 10g

m In the Available Products panel, select the Oracle 10g Database option
and click Next.

m  Choose the Basic or Advanced installation type.

For Basic installation:
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m In the Oracle Home Location box, type or select aname and a path
on the local disk for the Oracle Home.

This installs the Oracle binaries on the local disk. Use the same
Oracle_ Home name and path on all nodes.

m  Select Enterprise Edition.

m  Uncheck the Create Starter Database check box and click Next.
For Advanced installation:

m  Select the destination directory for the Oracle installation and
click Next.

m  Select Enterprise Edition and click Next.
m  Select Do not create a starter database.
6 Follow the wizard instructions, select options as per your configuration, and
complete the installation.

The Oracle installation also adds a Perl package. Make sure the path of the Perl
package appears as the first value in the PERL5LIB environment variable.

To modify the path of the Perl variable
1 Right-click My Computers and then click Properties.

2 Inthe System Properties window, on the Advanced tab, click Environment
Variables.

3 Inthe System Variables area of the Environment Variables window,
double-click the PERL5LIB variable name to edit it.

4 Inthe Variable Value field, add the path of the Perl package installed by
Symantec such that it is the first value in the definition. For example, add
the path C:\Program Files\Veritas\VRTSPerl\1lib; as the first
value in the definition. Note that you must add a semi-colon at the end of
the path.

After the Oracle installation is complete, verify if the Oracle home path (the
path that you set while installing Oracle) is included in the Path environment
variable. If not, then you have to manually add the Oracle home path to the Path
variable, on all the cluster nodes.

To add the oracle home path to the Path variable

1 Right-click My Computers and then click Properties.

2 Inthe System Properties window, on the Advanced tab, click Environment
Variables.

3 Inthe System Variables area of the Environment Variables window,
double-click the Path variable name to edit it.
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4 In the Variable Value field, add the Oracle home path.

5 Repeat steps 1 to 5 on all the cluster nodes.

Creating the database on shared disks

When run from the first node, this process creates an Oracle database on shared
disks. Before running this process from other nodes, rename the directories
containing the control files, redo log files, and the database files so that you
create new files from each node.

For example, if the Oracle database was created at the path H: \Oracle\Data,
rename it to H: \Oracle\Data_old. You can delete these renamed directories
after installing and configuring Oracle on all nodes in the cluster.

To create a database on a shared disk

1  Start the Database Configuration Assistant (Start > All Programs >
Oracle-Oracle_Home > Configuration and Migration Tools > Database
Configuration Assistant). This launches the database installer.

2 Inthe Welcome panel, click Next.
3 Inthe Operation panel, select Create a database and click Next.

4 Complete the following instructions depending on the Oracle version.

For Oracle 9i

m In the Database Templates panel, select New Database and click Next.

m Install the initialization file on the shared disk. In the Initialization
Parameters dialog box, click the File Locations tab.
In the Initialization Parameter Filename box, enter a path on the
shared disk for the PFILE. If you create an SPFILE, in the Server
Parameters Filename field, enter a path on the shared disk for the
SPFILE.

For Oracle 10g

m In the Database Templates panel, select the Custom Database option
and click Next.

m  Choose to install the database on the shared disk.
m  Choose to install the initialization parameter files on the local disk.

5 Follow the wizard instructions and select other options as per your desired
database configuration.

6 Install the control files, data files, and log files on the shared disk. In the
Database Storage panel, specify the locations of control files, data files, and
redo log files.

In the left pane, expand the Storage folder.
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Enter a path on the shared disk for each control file.

To do so, click Controlfile and click the General tab in the right pane. In
the File Directory field, enter a path on the shared disk.

Enter a path on the shared disk for each data file.

To do so, expand the Datafiles folder in the left pane. Select a data file,
and click the General tab in the right pane. In the File Directory field,
enter a path on the shared disk.

Enter a path on the shared disk for each redo log file
To do so, expand the Redo Log Groups folder in the left pane. Select a

redo log group and click the General tab in the right pane. In the File
Directory field, enter a path on the shared disk.

Click Next.

Select the Create database and the Generate Database Creation Scripts
options and click Finish.

Follow the wizard instructions and complete the installation.
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Creating a virtual IP address

All databases and listeners configured must use the same virtual IP. Create a
virtual IP address that can be set for all databases and listeners.

To create a virtual IP address
1 Open the Network Connections (Start > Settings > Network Connections).

2 Right-click the public network connection to be used and then click
Properties.

3  Select Internet Protocol (TCP/IP) and click Properties.

4  Click Advanced, and on the IP Settings tab, under IP addresses, click Add to
add a virtual IP address and subnet mask.

Creating the listener service

Create a listener service using the Net Configuration Assistant. Refer to the
Oracle documentation for instructions. Make a note of the listener name; you
will need it in subsequent configuration tasks.

Configuring the listeners to use the virtual IP address

In the file listener.ora file, change the host name to the virtual IP address that
you created.
Replace

HOST=machine_name
with

HOST=virtual_ IP_address
The default location of the file listener.ora is
$ORACLE_HOME%\NETWORK\ADMIN\.
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Associating the database with the listener

Use these instructions to associate all the databases with the listeners.

Prerequisite

Ensure that the initialization parameter file contains the following entries:

SERVICE_NAMES (the name of the database service)
INSTANCE_NAME (the name of the database instance)

These parameters are created during installation or database creation.

To associate the database with the listener

1

3

Use one of the following ways to configure the new attribute listener_alias:
Run the following SQL command:

SQL> ALTER SYSTEM SET LOCAL_LISTENER='<listener_alias>’
scope=spfile;

OR

Add the following entry to the initialization parameter file (pfile/spfile):

LOCAL_LISTENER = <listener_alias>

Define the parameter listener_alias. If your Oracle configuration uses the
file tnsnames.ora, edit the file as instructed below. The default location of
tnsnames.ora is $ORACLE_HOMES% \NETWORK \ ADMIN.

Add the following to tnsnames.ora file:

<listener_alias>=

(DESCRIPTION =

(ADDRESS= (Protocol=TCP) (HOST=virtual_ IP_address) (Port=1521))
)

Stop and restart the database.

The listener_alias parameter gets appended by the default domain name
specified in the file sqlnet.ora.
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Configuring the databases

Configuring the databases involves setting parameters in Oracle configuration
files. It involves setting the same virtual IP address for all the databases and
configuring the databases to use the OS authentication model of Oracle.

Updating the tnsnames.ora files

If your configuration has a tnsnames.ora file, edit the file as instructed below.
The default location of the file is $ORACLE _HOME% \NETWORK\ADMIN\.

Change the host name for all the TCP protocol address databases to the virtual
IP address that you created.

Replace
HOST=machine_name

with
HOST=virtual_ IP_ address

If you use a PFILE (initSID.ora)

Configure the PFILE to use the virtual IP address for the service group and set
the database to use the OS authentication model of Oracle.

1  Edit the dispatchers parameter by adding or editing the HOST parameter. If
the ADDRESS tag does not appear, add it. The edited dispatchers parameter
should look like:

dispatchers = ' (ADDRESS=(Protocol=TCP)
(HOST=virtual_ IP_address) (other entries))'

The variable virtual IP_address represents the virtual IP address that you
created.

For example:

dispatchers = ' (ADDRESS=(Protocol=TCP) (HOST=10.100.101.102)
(SERVICE=DatalXDB) '

2 Configure the attribute remote_login_passwordfile. Symantec
recommends setting the attribute to NONE so that the database uses OS
authentication and the configuration does not require a password file. A
sample entry appears as:

remote_login_passwordfile = 'NONE'
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If you use an SPFILE

m If you use an SPFILE on Oracle 10g, proceed to “Modifying the SPFILE
(Oracle 9i and 10g)” on page 33.

m  If you use an SPFILE on Oracle 9i, first modify the PFILE to point to the
SPFILE as instructed in“Modifying the PFILE (Oracle 9i only)” on page 33,
then update the SPFILE as instructed in “Modifying the SPFILE (Oracle 9i
and 10g)” on page 33.

Modifying the PFILE (Oracle 9i only)

On Oracle 9i, edit the PFILE so that it points to the SPFILE. The PFILE must
contain only the following entry:

SPFILE = spfile_location

The variable spfile_location represents the fully qualified path of the SPFILE on
the shared disk.

Modifying the SPFILE (Oracle 9i and 10g)

VCS requires a customized version of the SPFILE, which cannot be edited. But,
you can create a PFILE from the SPFILE, edit the PFILE, and convert it to an
SPFILE again.

1 Log on to the Oracle database as administrator and create a temporary
PFILE from the SPFILE.
C:\> sqglplus "/as sysdba"
SQL> create pfile='tmp pfile name' from spfile='spfile name';
For example:

SQL> create
pfile='C:\oracle\product\10.1.0\Db_1l\database\tempPF
ILE.ora' from
spfile='C:\oracle\product\10.1.0\Db_1l\database\SPFIL
EProd.ora-';

2 Edit the dispatchers parameter by adding or editing the HOST parameter. If
the ADDRESS tag does not appear, add it. The edited dispatchers parameter
should look like:
dispatchers = ' (ADDRESS=(Protocol=TCP) (HOST=virtual_ IP_address)
(other entries))'

The variable virtual IP_address represents the virtual IP address that you
created.

For example:

dispatchers = ' (ADDRESS=(Protocol=TCP) (HOST=10.100.101.102)
(SERVICE=DatalXDB) '

3 Configure the attribute remote_login_passwordfile. Symantec
recommends setting the attribute to NONE so that the database uses OS
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authentication and the configuration does not require a password file. A
sample entry appears as:

remote_login_passwordfile = 'NONE'

4 Create a temporary SPFILE from the edited PFILE.

SQL> create spfile= 'tmp spfile' from
pfile='temp pfile name';
For example:

SQL> create spfile=
1C:\oracle\product\10.1.0\Db_1l\database\temp SPFILE
Prod.ora:

from
pfile='C:\oracle\product\10.1.0\Db_1l1l\database\tempPF
ILE.ora';

5 Stop the database service.

6  Back up the original SPFILE by renaming it. For example, rename
SPFILEProd.oratooriginal_ SPFILE.ora.

7 Delete the original SPFILE (SPFILEProd.ora).

8 Rename the temporary SPFILE (temp_SPFILE.ora) to the name of the
original SPFILE (SPFILEProd.ora).

9 Start the database service.
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Moving the initialization file to shared disks (Oracle 10g)

For Oracle 10g, move the initialization files to the shared disk and configure the
SPFILE to start a database instance.

1

Verify which of the following initialization files exist in your configuration.
The default location of these files is $*ORACLE_HOME%\database.

m  SPFILESID.ora
m SPFILE.ora

m  initSID.ora
The variable SID represents the database instance.

Move the initialization files from the local disk to the shared disk, preferably
at the same location as the database control files.

Create a PFILE to specify the location of the SPFILE. The PFILE must be in
the same directory on the shared disk as the SPFILE.
Modify the PFILE so that it contain only the following entry:

SPFILE = spfile location
The variable spfile_location represents the fully qualified path of the
SPFILE on the shared disk.
For example, if your SPFILE is located at path H: \Oracle\Data, create a
PFILE sp_init.ora in the same location H: \Oracle\Data with the following
parameter:

SPFILE = H:\Oracle\Data\spfileSID.ora



36 | Installing and configuring Oracle
Installing and configuring Oracle

Setting the Oracle database parameters

1

Set the Oracle database parameters using the oradim utility. Type the
following at the command-prompt:

set ORACLE_SID=SID

The variable SID represents the database instance.

Run the following command:

%$ORACLE_HOME%\bin\oradim -edit =-sid SID -pfile
"pfile location on shared disk" -startmode auto -timeout 100
-shuttype srvc,inst -shutmode i

The variable SID represents the database instance.

This command performs the following tasks:

m Sets the -startmode parameter to start the database instance
automatically when Oracle service is started.

m  Setsthe -timeout parameter to 100. The timeout parameter specifies
the maximum wait time (in seconds) for the database shutdown to
complete before the service for a particular SID stops.

m  Setsthe -shuttype parameter to stop both the database instance and
the service while shutting the database.

m  Sets the -shutmode parameter to shut the database instance as soon
as the VCS database agent for Oracle requests.
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Verifying the initialization file settings
If a PFILE is used:

1

Open the Registry Editor.
From the Start menu, choose Run. In the Open field, enter regedit and
click OK.

2 Double-click the ORA_SID_PFILE registry key at
HKEY_ LOCAL_MACHINE\SOFTWARE\ORACLE\HOME_ID\.
The variable SID represents the database instance.

3 Verify that the Value data field specifies the fully qualified path of the PFILE
along with the file name.

If an SPFILE is used:

1 Stop and restart the database services.

2 Run sqlplus.exe.

3 Connect to the database.

4  Verify the following query returns the correct shared disk path for the

SPFILE.

select value from vSparameter where name = 'spfile';
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Configuring the Oracle and listener services

Set the startup type of the Oracle database and Listener services to manual
and configure the Log On properties for the Oracle services.

1

Open the Services applet (Start > All Programs > Administrative Tools >
Services).

Set the startup type of the Oracle database service to manual and configure
its Log On properties:

Double-click the Oracle database service. In the SCM, Oracle database
services appear as OracleServiceSID, where SID represents the
database instance.

In the Properties window, click the General tab.

From the Startup Type drop-down list, select Manual.

Click Stop to stop the service.

Click the Log On tab.

Choose This Account.

Enter the credentials of the user in whose context Oracle was installed.

Click the General tab and click Start to start the service with the new
Log On properties. Click OK.

Set the startup type of the Listener service to manual.

In the Services applet, double-click the listener service. Listener
services appear as OracleOra_HomeTNSListenerName, where
Ora_Home represents the Oracle home directory and ListenerName is
the name of the listener set during the installation.

In the Properties window, click the General tab.

From the Startup Type drop-down list, select Manual and click OK.
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Unmounting the volumes

Unmount the volumes only if you plan to install Oracle on more nodes. If this is
the last node for the Oracle installation, do not unmount the volumes.

Before unmounting volumes, stop the database and listener services.

To unmount the volume

1

o v A W

Open the Veritas Enterprise Administrator. Click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator.

From the VEA console’s tree view, right-click on the volume, and then click
File System > Change Drive Letter and Path.

In the Drive Letter and Paths dialog box, select Remove.
Click OK.
Repeat step 2 through step 4 for all the volumes to be unmounted.

From the VEA console’s tree view, right-click the disk and then click Deport
Dynamic Group.

Removing the virtual IP address

Remove the IP address if you plan to install Oracle on more nodes.

To remove the virtual IP address

1

2
3
4

Open the Network Connections (Start > Settings > Network Connections).
Right-click the public network connection to be used and click Properties.
Select Internet Protocol (TCP/IP) and click Properties.

Click Advanced and on the IP Settings tab, under IP Addresses, select the
virtual IP address that you added and click Remove.

Repeat the instructions in section “Installing and configuring Oracle” on
page 24 on each node in the cluster. If you have installed the Oracle agent,
proceed to “Configuring the Oracle service group” on page 43. Otherwise,
proceed to “Installing the Oracle agent” on page 41.
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Installing the Oracle agent

This chapter describes how to install the VCS database agent for Oracle in a VCS
cluster. Follow these instructions if you did not install the agent while installing
Storage Foundation HA for Windows.

Prerequisites

m  Verify you have SFW HA installed on all cluster nodes.

m  Verify you have local administrator privileges on the node where you are
installing the agent.

m  Verify Oracle is installed and configured identically on all nodes in the
cluster.

Installing the agent

This section instructs you on installing the Oracle agent.

Repeat these steps on all systems where the VCS database agent for Oracle is to
be installed.

To install the agent

1  Start the installer for SFW. In the Add/Remove Programs applet, click
Storage Foundation 5.0 for Windows and click Change.

2 Inthe Storage Foundation 5.0 for Windows dialog box, choose the Add or
Remove option and click Next.

3 Inthe SFW product options dialog box, click Next.
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Check the Veritas Cluster Server Database Agent for Oracle check box and
click Next.

The disk space required for the installation is displayed toward the bottom
of the screen. When you add or remove an option, the total space changes.

The installer validates the system for prerequisites. After the system is
accepted, click Next.

If a system is rejected, the Comments column displays the cause for
rejecting the system. Highlight the system to view a detailed information
about the failure in the Details box. Resolve the error, highlight the system
from the list, and click Validate Again.

An informational message appears if you selected the DMP option. Review
the information and click OK to continue.

Review the summary of your selections and click Update to start the
installation.

The installer displays the status of installation.

After the installation is complete, review the installation report and click
Next.

10 Click Finish.

After the agent is successfully installed in the cluster, proceed to “Configuring
the Oracle service group” on page 43 to configure the agent.



Configuring the Oracle
service group

Configuring the Oracle database agent involves creating the Oracle service
group, its resources, and defining attribute values for the configured resources.

VCS provides several ways to configure the Oracle agent: the agent
configuration wizard, the Java and Web consoles, and the command line. This
chapter provides instructions on how to use the agent configuration wizard to
configure the agent.

Oracle configurations in VCS

You can set up Oracle in different ways in a VCS environment.

m  Single Oracle instance configuration: Provides high availability for an Oracle
instance associated with a listener.

m  Multiple Oracle instances (single listener) configuration: Provides high
availability for one or more Oracle instances sharing a common listener.

m  Multiple Oracle instances (multiple listeners) configuration: Provides high
availability for one or more Oracle instances that are configured to one or
more listeners.



44 | Configuring the Oracle service group
Configuring the agent using the agent configuration wizard

Configuring the agent using the agent configuration

wizard

VCS provides an agent configuration wizard that guides you through the
process of configuring the Oracle agent. The wizard creates and modifies Oracle
service groups.

This section describes the steps required to create a new Oracle service group
using the wizard. To modify an existing service group, see “Modifying an Oracle
service group” on page 57.

Before configuring the Oracle agent, review the resource type and the attribute
definitions of the Oracle agents, described in “Resource type definitions” on
page 73. For sample configuration file and resource dependency graph of the
Oracle service group, see “Sample configuration” on page 79.
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You must be a Cluster Administrator. This user classification is required to
create and configure a service group.

You must be a Local or Domain Administrator on the node where you run
the wizard.

Verify that SFW HA, along with the VCS database agent for Oracle, is
installed on all cluster nodes. See “Installing the Oracle agent” on page 41
for instructions.

Verify a VCS cluster is configured using VCS Configuration Wizard (VCW).

Verify that the Veritas High Availability engine (HAD) is running on the
system from where you run the wizard.

Mount the shared drives containing the data files, control files, and redo log
files. Unmount the drives from other systems in the cluster.

Assign the virtual IP address on the system where you run the wizard.
Remove the virtual IP address from other systems

Mount the database and start the Oracle instance on the node running the
wizard.

Make sure that you have the following information ready; the wizard will
prompt you for this information:
m The databases and listeners to be monitored by VCS.

m For the instances to be monitored in detail, name and location of the
respective SQL files.

m  Avalid domain name, user name, and password with which the
database service was configured for the database.
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Configuration instructions

This section describes how to create an Oracle service group.

To create an Oracle service group

1

Start the Oracle configuration wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Database
Agent for Oracle > Oracle Configuration Wizard.

In the Welcome panel click Next.
In the Wizard Options panel, select Create service group and click Next.

In the Service Group Configuration panel, complete the following and click
Next. The wizard starts validating your configuration. Various messages
indicate the validation status.

f; Oracle Wizard

Service Group Configuration
Specily the sarvice aroup name and its system priority st

 Prerequisites
» Group Selection
Service Group Name: OracleSG

System Selection

SID Configuration

Detail Monitor Group System List

User C

Available Cluster Systems Systems in Priority Order
1P Configuration I SYSTEMZ  SYSTEM1

Summary

Complete

[«] =
KN L

< Back I Next > I Cancel

Service Group Name Type a name for the Oracle service group.
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Available Cluster Systems

Select the systems on which to configure the
service group and click the right arrow to move
the systems to the Systems in Priority Order box.

The Systems in Priority Order box represents the
service group’s system list. The system at the top
of the list has the highest priority while the
system at the bottom of the list has the lowest
priority.

To remove a system from the service group’s
system list, select a system in the Systems in
Priority Order box and click the left arrow.

To change a system’s priority in the service
group’s system list, select the system from the
Systems in Priority Order box, and click the up
and down arrows.

5 Inthe Oracle Configuration panel, select the SIDs and the associated
listeners to be added to the service group, and click Next.

£2 Oracle wizard

Oracle Configuration
Select the database Instances ($1D) and its listeners

+ Prerequisites

+ Group Selection

as child nodes.
¥ SID Configuration

+ System Selection Listed below are all the discovered databases with their comesponding listeners

Selact the databases and assaciated listener(s] to bs added to the servics group

Detail Monitor

SID and Listeners |

User Configuration
IP Configuration
Summary

Complete

<Back [ News | Coancel |

The SID is a system identifier that uniquely identifies the Oracle database
instance, while the listener is the name of the corresponding listener

service.
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6  On the Detail Monitoring panel, configure detail monitoring for the Oracle
database if required, and click Next.

TE Oracle Wizard [x]
Detail Monitoring
Select the SIDs that require detail moritoring M
+ Prerequisites
+ Group Selection
+ System Selection Select the databases to be monitored in detail and specify the sssociated SHL sript file
+ SID Configuration
Detail Monitor SID |5QL Path
» Detail Monitor [ VCSDEL C:\Program Files\Veritas\cluste
User Configuration
IP Configuration
Summary
Complete
< Back Mext > Cancel
Detail Monitor Check the Detail Monitor option corresponding to each
database that you want to configure detail monitoring for.
SQL Path Type the path of the SQL file that will query the database

to validate the status. Click the icon next to the field to
browse for the SQL file.

A sample SQL file, check.sql, is located at
$VCS_HOME%\bin\Oracle\.

7 Inthe Domain and User selection panel, type a valid domain name, user
name, and password with which the database service was configured for the
database and click Next. See “Configuring the Oracle and listener services”
on page 38 for more information.
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On the Network Configuration panel, specify the network related
information and click Next.

The wizard discovers and displays the virtual IP address for the Oracle
Server.

& Dracle Wizard [ x]

Network Configuration
Configure your [P and NIE resources.

 Prerequisites

S Stz itus! 1P Addrsss W10 W1
 System Selection
+ SID Configuration Subnet Mask 00 100 100 0

+ Detail Monitor

+ User Configuration Specify the adapter to be used on each system,

} IP Configuration

System Hame Adapter Display Hame
Summary SYSTEM1 Local Area Connection
SYSTEMZ Local Area Connection
Complete
< Back I Mext > I Cancel
Subnet Mask Type the subnet mask to which the virtual IP belongs.
Adapter Display Name For each system in the cluster, select the public network

adapter. Select the Adapter Name field to view the
adapters associated with a system.

The wizard displays all TCP/IP enabled adapters on a system, including the
private network adapters, if they are TCP/IP enabled. Make sure that you
select the adapters to be assigned to the public network, and not those
assigned to the private network.
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10

11

Review the configuration on the Summary panel and click Next.

{3 Oracle Wizard

Service Group Summary
Review the configuration. Use F2 to enable edit for resounce names. iy
+ Prerequisites
+ Group Selection Press F2 or click on the selected iesource ta edit the name of the resource:
+ System Selection Resources | Attibutes |
ERF) Cocicoi System List = SYSTEMT- GYSTEMZ |
 SID Configuration 3 Oracke VCSDET
- @ Netsnr-LISTENER
+ Detail Monitor 3 OrackSGYMDg
_ @ OracleSG-Mounty
+ User Configuration 4 DrackeSEHIC
+ IP Configuration & OracleSGP
» Summary
Complete
Click Nest to creats e service group
< Back I Mext > I Cancel
Resources Lists the configured resources. Click on a resource to view its

attributes and their configured values in the Attributes box.
The wizard assigns unique names to the resources. To edit a
resource name, select the resource name and click on it, or
press the F2 key. After the edit, press the Esc key to cancel the
changes, or press the Enter key to confirm the changes.

In the confirmation dialog box, click Yes. Click No if you wish to review your
settings.

The wizard starts running commands to create the Oracle service group. On
the Completing the Oracle Configuration panel, check Bring the service
group online to bring the service group online on the local system, and click
Finish. The Oracle service group is created in your cluster.

After verifying that the service group comes online on the node, remove the
virtual IP address that you created earlier.

To remove the virtual IP address

1 Take the Oracle service group offline on the node.

2 Remove the virtual IP address. See “Removing the virtual IP address” on
page 39 for instructions.

3 Bring the Oracle service group online.
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Configuring dependent services

If the database service has other dependent services, make sure the dependent
services are running on the node where the database service is online. Note that
the online agent operation brings only the database service online and not the
dependent services.

For example, on Oracle 10g, the DBConsole service corresponding to an Oracle
database has a dependency on the database service. That is, for the Enterprise
Manager to manage the databases, you must make sure the DBConsole service is
running on the node where the database service is online.

To configure a dependent service
1 For the dependent service, add a GenericService resource manually.

2 Make the GenericService resource dependent on the corresponding Oracle
resource.

3 Set the Critical attribute to False if the Oracle service group must not fail
over when the GenericService resource faults.

Refer to the Veritas Cluster Server Administrator’s Guide for configuration
instructions.
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Verifying the Oracle service group configuration

This section provides steps to verify an Oracle service group configuration by
bringing the service group online, taking it offline, and switching the service
group to another cluster node.

Bringing the service group online

Perform the following steps to bring the service group online from the VCS Java
or Web Console.

To bring a service group online from the Java Console

1 Inthe Cluster Explorer configuration tree, select the Oracle service group to
be taken online.

2 Right-click the service group and select to online the service group on the
system. (Right-click > Online > system_name)
To bring a service group online from the Web Console

1  Onthe Service Group page (Cluster Summary > All Groups > Service Group),
click Online.

2 Inthe Online Group dialog box, select the system on which to bring the
service group online.

3 To run PreOnline script, select the Run PreOnline Script check box.

4  Click OK.
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Taking the service group offline

Perform the following steps to take the service group offline from the VCS Java
or Web Console.

To take a service group offline from the Java Console

1 On the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2 Choose Offline, and choose the appropriate system from the pop-up menu.
(Right-click > Offline > system_name)
To take a service group offline from the Web Console

1  Onthe Service Group page (Cluster Summary > All Groups > Service Group),
click Offline. This opens the Offline Group dialog box.

2 Select the system on which to take the service group offline.

3 Click OK.
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Switching the service group

The process of switching a service group involves taking it offline on its current
system and bringing it online on another system.

To switch a service group from the Java Console

1 Inthe Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2 Choose Switch To, and choose the appropriate system from the pop-up
menu. (Right-click > Switch To > system_name)

To switch a service group from the Web Console

1  From the Service Group page (Cluster Summary > All Groups > Service
Group), click Switch.

2 Inthe Switch Group dialog box, select the system to switch the service group
to.

3 Click OK.
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Disabling the service group

To disable the agent, you must change the Oracle service group to an OFFLINE
state. You can stop the application completely or switch the agent to another
system.

To disable a service group from the Java Console

1 Inthe Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2 Choose Disable, and choose the appropriate system from the pop-up menu.

To disable a service group from the Web Console

1 Inthe Service Group page (Cluster Summary > All Groups > Service Group),
click Disable. This opens the Disable Group dialog box.

2 Select the system on which to disable the service group. To disable the
service group on all systems, click All Systems.
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Administering the Oracle
service group

This chapter describes the administrative tasks you can perform on Oracle
service groups such as modifying the service group configuration and deleting a
service group. The chapter also describes steps to configure detail monitoring
for an Oracle database.

Modifying an Oracle service group

The following steps describe how to modify the configuration of the service
groups using the configuration wizard.

Prerequisites

m Ifthe Oracle service group is online, you must run the wizard from a node on
which the service group is online. You can then use the wizard to add
resources to and remove them from the configuration. You cannot change
resource attributes.

You can however enable and disable the SIDs and listeners to be monitored
in detail and change their detail monitoring options when the Oracle service
group is online.

m  To change the resource attributes, you must take the service group offline.
However, the MountV and VMDg resources for the service group should be
online on the node where you run the wizard and offline on all other nodes.

m  If you are running the wizard to remove a node from the service group’s
system list, do not run the wizard on the node being removed.
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Instructions

To modify an Oracle service group

1

Start the Oracle configuration wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Database
Agent for Oracle > Oracle Configuration Wizard.

Review the prerequisites and click Next.

In the Wizard Options panel, click Modify service group, select the service
group to modify, and click Next.

Follow the wizard instructions and make desired modifications to the
service group configuration. See “Configuring the agent using the agent
configuration wizard” on page 44 for instructions.

Deleting an Oracle service group

The following steps describe how to delete an Oracle service group using the
configuration wizard.

To delete an Oracle service group

1

Start the Oracle configuration wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Database
Agent for Oracle > Oracle Configuration Wizard.

Review the prerequisites and click Next.

In the Wizard Options panel, click Delete service group, select the service
group to delete, and click Next.

In the Service Group Summary panel, click Next.

On the message that informs you that the wizard will run commands to
delete the service group, click Yes to delete the service group and then click
Finish.
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Configuring detail monitoring

Use the detail monitoring capability of VCS database agent for Oracle to monitor
the status of a database. Before setting up detail monitoring, you must have the
agent running at the basic level of monitoring, that is, the DetailMonitor
attribute must be set to 0.

The Oracle agent uses a script to monitor the status of the database. A sample
SQL script, located at $VCS_HOME%\bin\Oracle\check.sql,is provided with
the agent for the purpose. If the script is successfully executed during
monitoring, the agent considers the database instance available. If the execution
fails, the database instance is considered not available and the service group
faults and fails over to the failover nodes. You can customize the script to meet
your configuration requirements.

Note: You must use a separate script for each Oracle service group that exists in
the cluster. The script must exist on all the nodes in the service group.

Enabling detail monitoring

The following steps describe how to enable detail monitoring using the
configuration wizard.

To enable detail monitoring

1  Start the Oracle configuration wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Database
Agent for Oracle > Oracle Configuration Wizard.

2 Review the prerequisites and click Next.

3 Inthe Wizard Options panel, click Modify service group, select the service
group configured for the instance to be monitored in detail, and click Next.

4 Inthe Oracle Configuration panel, select the SIDs to be configured along
with their respective listeners and click Next.
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5 Inthe Detail Monitoring dialog box, specify information to enable detail
monitoring, and click Next.

{3 Oracle Wizard

X]
Detail Monitoring
Select the 51Dz that require detail monitoring .M
+ Prerequisites
+ Group Selection
+ System Selection Select the databases to be monitared in detail and specity the associsted SOL script file.
+ SID Configuration
Detail Monitor SID ISQL Path
» Detail Monitor " WCSDB1 i \Program FileslVeriasichuste
User Configuration
IP Configuration
Summary
Complete
< Back Mext > Cancel
Detail Monitor Check the Detail Monitor option corresponding to each
database that you want to configure detail monitoring for.
SQL Path Type the path of the SQL file that will query the database

to validate the status. Click the icon next to the field to
browse for the SQL file.

A sample SQL file, check.sql, is located at
$VCS_HOME%\bin\Oracle\.

6 Inthe Domain and User selection panel, type a valid domain name, user
name, password, and then click Next.

7  Follow the wizard instructions and accept the default values in the
subsequent dialog boxes. See “Configuring the agent using the agent
configuration wizard” on page 44 for instructions.
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Disabling detail monitoring

The following steps describe how to disable detail monitoring using the
configuration wizard.

To disable detail monitoring

1

Start the Oracle configuration wizard. Click Start > All Programs >
Symantec > Veritas Cluster Server > Configuration Wizards > Database
Agent for Oracle > Oracle Configuration Wizard.

Review the prerequisites and click Next.

In the Wizard Options panel, click Modify service group, select the service
group configured for the instance for which detail monitoring is being
disabled, and click Next.

In the Oracle Configuration panel, click Next.

In the Detail Monitoring Configuration panel, uncheck the check box
corresponding to the Oracle Server instance for which detail monitoring is
being disabled and click Next.

Follow the wizard instructions and accept the default values in the
subsequent dialog boxes. See “Configuring the agent using the agent
configuration wizard” on page 44 for instructions.
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Troubleshooting the
Oracle agent

This chapter lists some commonly encountered problems with the Oracle agent
and some possible solutions. It also lists the error messages associated with the
VCS database agent for Oracle. Each message includes a description and a
recommended solution, if applicable.
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Troubleshooting common problems

Occasionally you may encounter problems when using the Oracle database
agent. Table 6-1 describes the most common problems and provides standard

workarounds.
Table 6-1 Common problems when using Oracle database agent
Error Description

The Oracle service starts, but
does not start the database.

Make sure the Oracle database parameter startmode
is setto auto.

Make sure the path of the initialization file is set
correctly.

Verify access to the shared disk.

Clients cannot connect to the
virtual IP address set for the
service group.

Make sure that the listener service is running. Verify
that the listener is configured with virtual IP address in
the host location.

Clients get disconnected
during failover.

Configure Transparent Application Failover (TAF) for
the client in the tnsnames . ora file. For more
information on TAF, see the Oracle documentation.

Resource returns offline
during detail monitoring.

This could occur because the database is offline or has
not been mounted or opened properly. Check the error
in the log file for further details.

Verify the configuration definition of the agent. Make
sure that the correct file name is specified in the
configuration. Verify access to sqlplus from the
command prompt.

The sqlplus script cannot be
run because sqlplus returns a
process error.

If the script timed out, increase the timeout value set in
the attribute SQLTimeOut. Otherwise, try recreating the
Oracle service using the oradim utility.

The Oracle wizard could not
locate PFILE or SPFILE for a
database.

Make sure the initialization file settings are configured
correctly. See “Verifying the initialization file settings”
on page 37.

Could not locate the PFILE
entry in the registry.

Recreate the registry entry by running the following
command:

%ORACLE_HOME%\bin\oradim -edit -sid SID
-pfile "initialization_ file"
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Error

Description

The Oracle service starts, but
the database does not start
when a non-default SPFILE is
used.

Start the database using the command-line.

1 Start SQL*Plus.
sglplus /nolog

2 Connect to the database as SYSDBA.
connect username/password as
sysdba

3  Type:
startup pfile="initialization_file"
The variable initialization_file represents the name
of the PFILE that you created to point to the
non-default SPFILE on the shared disk (see
“Moving the initialization file to shared disks
(Oracle 10g)” on page 35). You must specify the

fully qualified path of the file, along with its name.

4  If the database is mounted and does not open, type:

alter database open;

Refer to the Oracle documentation for more
information.

Listener service does not start
after configuring the virtual IP
address.

Make sure the virtual IP address is configured correctly
for the listeners.

Another possible cause is that the listener.ora file is
corrupted.

Solution:
1  Stop the listener services on the node.
2 Rename the listener.ora file.

3 Recreate the listeners using the Net Configuration
Assistant.

Bring up the virtual IP on the node.
Configure the virtual IP address for the newly
created listeners using the Net Manager.

6  Restart the listener services.
Run lsnrctl status command for each
listener to verify the virtual IP address.

Refer to the Oracle documentation for instructions on

using the Net Configuration Assistant and the Net
Manager.
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Table 6-1 Common problems when using Oracle database agent (Continued)

Error

Description

The VRTSWeb service does not
start.

Make sure the path of the Perl package installed by
Veritas appears as the first entry in the definition of the
PERL5LIB environment variable. See “To modify the
path of the Perl variable” on page 27 for instructions.
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VCS logging

VCS generates two error message logs: the engine logs and the agent logs. Log
file names are appended by letters. Letter A indicates the first log file, B the
second, C the third, and so on.
The agent log is located at %VCS_HOME%\log\agent_A.txt. The format of agent
log messages is:
Timestamp (Year/MM/DD) | Mnemonic | Severity | UMI | Agent Type |
Resource Name | Entry Point | Message Text

A typical agent log resembles:
2005/05/10 09:32:44 VCS NOTICE V-16-20046-5 Oracle:
Oracle-DATAl:online:Service status is Running

Here,
m Timestamp denotes the date and time when the message was logged.

m  Mnemonic denotes which Symantec product logs the message. For VCS
database agent for Oracle, mnemonic is ‘VCS’.

m  Severity denotes the seriousness of the message. Severity of the VCS error
messages is classified into the following types:

m CRITICAL indicates a critical error within a VCS process. Contact
Technical Support immediately.

m  ERROR indicates failure of a cluster component, unanticipated state
change, or termination or unsuccessful completion of a VCS action.

WARNING indicates a warning or error, but not an actual fault.
m  NOTE informs the user that VCS has initiated an action.

m INFO informs the user of various state messages or comments.
Of these, CRITICAL, ERROR, and WARNING indicate actual errors.
NOTE and INFO provide additional information.

m  UMI or Unique Message ID is a combination of Originator ID, Category ID,
and Message ID. For example, the UMI for a message generated by the Oracle
agent would resemble: V-16-20046-5
Originator ID for all VCS products is ‘V-16.” Category ID for Oracle agent is
20046, for Netlsnr agent is 20047. Message ID is a unique number assigned
to the message text.

m  Message text denotes the actual message string.

You can view these message logs using Notepad or any text editor. All messages
are logged to the engine and the agent logs. Messages of type CRITICAL and
ERROR are written to the Windows event log.
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Error messages and descriptions

Table 6-2 and Table 6-3 lists the messages of type ERROR and WARNING. Each
message includes a description and a recommended solution, if applicable.

Oracle agent

Table 6-2 Oracle agent error messages

Message

Description

Cannot open service handle.

The agent could not open the Service Control Manager
handle. This may occur because of an invalid service
name.

Solution: Verify that the correct service name is
specified in the configuration definition of the agent.

Cannot close service handle.

The agent could not close the Service Control Manager
handle.

Solution: Verify that the specified service is running.

Cannot start service.

The agent could not start the specified service. This

may occur because of the following:

B The specified SCM handle does not have access to
the service. or

m  The specified handle is invalid.

Solution: Verify that the service name in the
configuration file is the same as the name displayed
by the SCM. Verify that the specified service is
supported by the host. Verify that the service is listed
in the SCM window.

Cannot stop the service.

The agent could not stop the specified service. This
may occur because of the following:

m  The specified service was not opened
successfully.
or

m  The specified service was not opened with the
required access.

Solution: Verify that the service was opened
successfully. Check the access with which the service
was opened.
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Table 6-2 Oracle agent error messages (Continued)

Message

Description

Wait for mutex failed.

The wait function for mutex failed. This message is
followed by an error code. Check the error code for
more information.

Wait for mutex abandoned.

The mutex object is was not released by the thread
that owned the mutex object before the thread
terminated. This indicates a possibility that the SQL
script is not terminated.

Solution: Verify that the SQL script executed correctly.

Cannot wait for mutex object.

The agent could not acquire mutex for the resource.
This may occur if two or more Oracle resources
configured.

Solution: Verify that the SQL script executed correctly.

Failed to decrypt password.

The agent could not decrypt the domain password.

Solution: Verify that the password was encrypted
using the VCS Encrypt utility.

No domain specified in argument
list.

The attribute Domain is not configured for the
resource.

Solution: Verify that the correct Domain is defined in
the configuration file.

No username specified in
argument list.

The attribute UserName is not configured for the
resource.

Solution: Verify that the correct UserName is defined
in the configuration file.

No password specified in
argument list.

The attribute Password is not configured for the
resource.

Solution: Verify that the password is encrypted using
the VCS Encrypt utility. Verify that the correct
encrypted password is defined in the configuration
file.

No SID specified in argument
list.

The configuration definition of the agent does not
contain a value for the attribute SID.

Solution: Verify that the attribute SID is correctly
defined in the configuration file.

SQL*Plus process exited with
error error_code.

The agent could not execute the SQL*Plus process
correctly. See the associated error code for more
information.
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Table 6-2 Oracle agent error messages (Continued)

Message

Description

Invalid filename in argument list
file_name.

The SQL script for the resource is incorrectly defined
in the filename.

Solution: Verify that the attribute SQLFile is correctly
defined in the configuration file. Verify the validity of
the file name and path.

An Oracle error occurred.

An error occurred while generating the SQL script.
This is an Oracle error and the corresponding error
number and error message is logged to the agent log.

Netlsnr agent

Table 6-3 Netlsnr agent error messages

Message

Description

Cannot open service handle.

The agent could not open the Service Control
Manager handle. This may occur because of an
invalid service name.

Solution: Verify that the correct service name is
specified in the configuration definition of the agent.

Cannot start service.

The agent could not start the specified service. This

may occur because of the following:

m  The specified SCM handle does not have access
to the service. or

m  The specified handle is invalid.

Solution: Verify that the service name in the
configuration file is the same as the name displayed
by the SCM. Verify that the specified service is
supported by the host. Verify that the service is listed
in the SCM window.
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Table 6-3 Netlsnr agent error messages (Continued)

Message

Description

Cannot stop the service.

The agent could not stop the specified service. This

may occur because of the following:

m  The specified service was not opened
successfully.

B The specified service was not opened with the
required access.

Solution: Verify that the service was opened
successfully. Check the access with which the service
was opened.

Cannot close service handle.

The agent could not close the Service Control
Manager handle.

Solution: Verify that the specified service is running.
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Resource type definitions

This appendix lists the resource type definitions and attribute definitions of the
Oracle and Netlsnr agents.

The resource type represents the VCS configuration definition of the agent and
specifies how the agent is defined in the configuration file main.cf. The
Attribute Definitions table explains the attributes associated with the agent. The
Required attributes table lists the attributes that must be configured for the
agent to function properly.

Oracle agent

Type definition

type Oracle (

static keylist LogDbg = { DBG_1 }

static i118nstr ArgList([] = { ServiceName, DelayAfterOnline,
DelayAfterOffline, DetailMonitor, IndepthMonitorCount, SID,
Domain, UserName, EncryptedPasswd, SQLFile, SQLTimeOut }

str ServiceName

int DelayAfterOnline = 2

int DelayAfterOffline =

boolean DetailMonitor =

int IndepthMonitorCount

str SID

str Domain

str UserName

I o N o
o

str EncryptedPasswd
str SQLFile
int SQLTimeOut = 20



74 | Resource type definitions

Oracle agent

Attribute definitions

Table A-1

Oracle agent - required attributes

Required Attribute

Type and
Dimension

Definition

ServiceName

string-scalar

The name of the Oracle service set during the
installation of Oracle. The service name is
specified in the format OracleServiceSID, where
SID represents the database instance.

Domain

string-scalar

The name of the domain to which the user
belongs in whose context Oracle was installed.

SID

string-scalar

A system identifier that uniquely identifies the
Oracle database instance to be monitored in
detail.

UserName

string-scalar

The name of the domain user in whose context
Oracle was installed.

EncryptedPasswd

string-scalar

The encrypted password for the user identified
by UserName. The password must be encrypted
with the VCS Encrypt utility.

Table A-2

Oracle agent - optional attributes

Optional Attributes

Type and
Dimension

Definition

DelayAfterOffline

integer-scalar

Number of seconds the agent waits to start the
monitoring routine after Oracle is taken
offline.

Default = 20

DelayAfterOnline

integer-scalar

Number of seconds the agent waits to start the
monitoring routine after Oracle is brought
online.

Default = 20
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Table A-2 Oracle agent - optional attributes (Continued)

Optional Attributes

Type and
Dimension

Definition

DetailMonitor

boolean-scalar

A flag that defines whether the agent
monitors Oracle in detail by trying to verify
access to the database by running a SQL
script. The value 1 indicates that the agent will
monitor Oracle in detail. The value 0 indicates
that the agent will not.

Default = 0

If the DetailMonitor flag is set to 1, the
following attributes must be defined:

m SID

m  SQLFile

IndepthMonitorCount

integer-scalar

An integer that defines the monitor interval
between two consecutive detail monitoring
cycles. If this attribute is set to 5, the agent
monitors the application in detail after every
five monitor intervals.

Default =5

SQLTimeOut

integer-scalar

The number of seconds the agent waits for the
SQL script to return a value during detail
monitoring. If this limit exceeds, the resource
is declared faulted.

Default = 20

SQLFile

string-scalar

The name of SQL script to be used for detail
monitoring, along with its complete path. The
agent verifies the existence of this file.

A sample file, check.sql, is located at
% VCS_HOME%\bin\Oracle\. The sample

file contents are:

select * from v$database;

Do not include any spool commands within the
SQL script.

If an Oracle error occurs during execution, the
error is logged to the agent log. If debug
logging is also enabled for the resource, the
output of the SQL script is also logged to the
agent log.
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Netlsnr agent

Type definition

type Netlsnr (

static i118nstr ArgList[] =

Resource type definitions
Netlsnr agent

{ ServiceName, DelayAfterOnline,

DelayAfterOffline }
str ServiceName

int DelayAfterOnline =
int DelayAfterOffline =

Attribute definitions

Table A-3

20
20

Netlsnr agent - required attributes

Required
Attribute

Type and Definition

Dimension

ServiceName

string-scalar | The name of the configured listener service.

The service name is specified in the format
OracleOraHomeTNSListenerName, where
OraHome represents the Oracle home set during the
installation and ListenerName represents the
name of the configured listener.

Table A-4

Netlsnr agent - optional attributes

Optional
Attributes

Type and Definition

Dimension

DelayAfterOffline

integer-scalar | Number of seconds the agent waits to start the

monitor routine after the listener is taken offline.

Default = 20

DelayAfterOnline

Number of seconds the agent waits to start the
monitor routine after the listener is brought
online.

integer-scalar

Default = 20
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Sample configuration

This appendix describes a typical service group configured to monitor the state
of Oracle in a VCS cluster. The sample dependency graph depicts the resource
types, resources, and resource dependencies within the service group. The
sample configuration file (main.cf) is also included for your reference. Review
the dependency carefully before configuring the agent. For more information
about VCS resource types, see the Veritas Cluster Server Bundled Agents
Reference Guide.

Resource dependency graph

In the sample configuration shown in the dependency graph below, the shared
disk group is configured using the Volume Manager (VMDg) agent. The shared
volume on which Oracle shared data is installed is mounted as drive G:\ using
the MountV agent. The service group IP address for the server is configured
using the IP and NIC resource types. The Oracle resource can be started after
each of these resources is brought online.

Figure B-1 Sample Oracle service group resource dependency graph

ra_netlsnr

ora_oracle

ora_ip ora_mountv

. ora_vmdg
ora_nic
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Sample configuration file

include "types.cf"

cluster oraclus (
UserNames = { admin = "1F[YcdW eaYbddX"zZ " }
Administrators = { admin }

system VCSW2K67 (
)

system VCSW2K68 (
)

group OraVM (
SystemList = { VCSW2K67 = 1, VCSW2K68 = 2 }

IP Ora_IP (
Address = "172.29.10.254"
SubNetMask = "255.255.255.0"
MACAddress @VCSW2K67 = "00-02-B3-02-AE-81"
MACAddress @QVCSW2K68 = "00-D0-B7-8E-D8-35"

MountV Ora_MountV (
MountPath = "G:"
VolumeName = Oracle
VMDGResName = Ora_VMDg

NIC Ora_NIC (
MACAddress @VCSW2K67 = "00-02-B3-02-AE-81"
MACAddress @QVCSW2K68 = "00-D0-B7-8E-D8-35"

Netlsnr Ora_Netlsnr (
ServiceName = OracleOraHome92TNSListener

)

Oracle Ora_Oracle
ServiceName = OracleServiceOra
DetailMonitor = 1
SID = Ora
Domain = vcsnet
UserName = Administrator
EncryptedPasswd = FTLrITi
SQLFile = "D:\\Program Files\\Veritas\\cluster
server\\bin\\Oracle\\check.SQL"



Sample configuration
Sample configuration file

VMDg Ora_VMDg (
DiskGroupName = VCSDG
ForceDeport = 1
ListMountedvVolumes

=1
ListApplications = 1

Ora_IP requires Ora_NIC
Ora_MountV requires Ora_VMDg
Ora_Oracle requires Ora_IP
Ora_Oracle requires Ora_MountV
Ora_Netlsnr requires Ora_Oracle
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Oracle Enterprise Manager
10g Grid Control with VCS

Oracle Enterprise Manager (OEM) 10g allows users to manage Oracle
components, including Oracle databases, through the Grid Control Management
interface.

This appendix covers general instructions on how to install the Oracle 10g Grid
Control Management Agent, and detailed step-by-step instructions on how to
set up the Oracle Enterprise Manager 10g Grid Control to enable users to
manage Oracle databases from the Oracle Enterprise Manager console, in a VCS
cluster.

Supported software and operating system

m  Oracle 10g, Release 2 (10.2.0.1.0) Standard Edition or Enterprise Edition
with
Windows 2000 Server, Advanced Server, or Datacenter Server (all require
Service Pack 4 with Update Rollup1)
or
Windows Server 2003 (Standard Edition, Enterprise Edition, or Datacenter
Edition) (SP 1 required, SP2 supported, but not required for all editions)

m  Oracle Enterprise Manager 10g Grid Control Release 10.1.0.3

m  Storage Foundation HA 5.0 for Windows (SFW HA) with the Veritas Cluster
Server Database Agent for Oracle

Note: SFW HA support for Oracle is limited to 32-bit versions of the operating
system.
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Installation and configuration tasks

Perform the following steps to configure Oracle Enterprise Manager 10g Grid
Control to monitor databases in a VCS environment:

Install the Oracle Enterprise Manager. See “Installing Oracle Enterprise
Manager server” on page 85.

Install Oracle binaries. See “Installing Oracle” on page 85.

Install the Oracle Management Agent. See “Installing the Oracle
management agent” on page 86.

Create and configure the Oracle database and listener. See “Creating and
configuring Oracle database and listener” on page 86.

Add the Lanman resource for the virtual network name and bring it online.
See “Configuring a virtual network name” on page 87.

Configure the listener for the virtual network name. See “Configuring the
listener for virtual network name” on page 88.

Configure the database service for the virtual network name. See
“Configuring the database service for virtual network name” on page 88.

Configure an additional Oracle Management Agent listening on a virtual
network name. See “Configuring an additional Oracle management agent”
on page 90.

Add the database to the Oracle Enterprise Manager 10g Grid Control. See
“Adding the database to the OEM 10g Grid Control” on page 90.

Add a GenericService resource for the Additional Management Agent. See
“Click Next and follow the instructions to complete the database
configuration. After you configure the database successfully, the tools icon
will appear as .” on page 91.



Oracle Enterprise Manager 10g Grid Control with VCS | 85
Installing Oracle Enterprise Manager server

Installing Oracle Enterprise Manager server

Install the Enterprise Manager server on a separate server. The Enterprise
Manager server should not be a part of the cluster.

To install the Enterprise Manager server

1  From the Oracle Enterprise Manager CD, double-click Setup.exe to launch
the Oracle Universal Installer.

2 On the Welcome panel, click Next.

3 On the Specify File Locations panel, specify the appropriate paths required
for the installation and click Next.

4  On the Select a Product to Install panel, choose Enterprise Manager 10g
Grid Control Using a New Database 10.1.0.3.0 and click Next.

5 Follow the instructions of the installer. Refer to the Oracle product
documentation for more information. At the end of the installation, make a
note of the information displayed on the Summary page. You may need this
information to complete the configuration.

Installing Oracle

Install Oracle on all the cluster nodes. Follow the instructions given on pages 17
to 27 of the VCS 5.0 Database Agent for Oracle Configuration Guide.

After the Oracle installation is complete, verify if the Oracle home path (the
path that you set while installing Oracle) is included in the Path environment
variable. If not, then you have to manually add the Oracle home entry to the
Path variable, on all the cluster nodes.

To add the oracle home to the Path variable

1 Right-click My Computers and click Properties.

2 Inthe System Properties window, click the Advanced tab.
3 Click Environment Variables.
4

In the System Variables area of the Environment Variables window,
double-click the Path variable name to edit it.

(§]

In the Variable Value field, add the Oracle home path.
6 Repeat steps 1 to 5 on all the cluster nodes.
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Installing the Oracle management agent

Install the Oracle Management Agent on all the cluster nodes under the same
Oracle home path.

To install the Oracle Management Agent

1

8

From the Oracle Enterprise Manager CD, double-click Setup.exe to launch
the Oracle Universal Installer.

On the Welcome panel, click Next.

On the Specify File Locations panel, specify the appropriate paths required
for the installation and click Next.

On the Select a Product to Install panel, choose Additional Management
Agent 10.1.0.3.0 and click Next.

On the Specify Oracle Management Service Location panel, specify the host
name (the Enterprise Manager Server name) and the port (default port) that
the Management Agent should use to communicate with the Enterprise
Management service.

The installer might display a Warning. Click OK to continue.

Click Next. Follow the instructions of the installer to complete the
installation.

Repeat steps 1 to 7 on all the cluster nodes.

You must install the Oracle Additional Management Agent under the same
Oracle Home Path on all the cluster nodes.

Creating and configuring Oracle database and

listener

Before you proceed, ensure that you have installed the VCS Database Agent for
Oracle. See “Installing the Oracle agent” on page 41 for instructions.

To create and configure an Oracle database and a listener

1

Create a virtual IP address for the databases and the listeners. See “Creating
a virtual IP address” on page 30 for instructions.

Create a Listener service. See “Creating the listener service” on page 30 for
more instructions.

Configure the listener to use the virtual IP address. See “Configuring the
listeners to use the virtual IP address” on page 30 for instructions.
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Use the Oracle Database Configuration Assistant (DBCA) to create the
database.

m Start the Database Configuration Assistant (Start > All Programs >
Oracle-Oracle_Home > Configuration and Migration Tools > Database
Configuration Assistant). This launches the database installer.

m  On the Welcome panel, click Next.
m  On the Operation panel, click Create a database and click Next.

m  On the Database Templates panel, click Custom Database and click
Next.

m  On the Management Options panel (Step 4 of 12), choose Use Grid
Control for Database Management.

m  Click Next. Follow the installer instructions and select other options as
per your desired database configuration. See “Creating the database on
shared disks” on page 28 for instructions.

Configure the database on the shared disk. Follow the instructions given on
pages 32 to 40 of the VCS 5.0 Database Agent for Oracle Configuration Guide
with one exception. On page 38, Configuring the Oracle and Listener
Services, step 2, bullet 6, choose Local System Account instead of This
Account.

Repeat step 1 to step 5 on all the cluster nodes.

Configure the Oracle Service group. Refer to Chapter 4, “Configuring the
Oracle Service Group” pages 43 to 51 of the VCS 5.0 Database Agent for
Oracle Configuration Guide for more information.

Configuring a virtual network name

See the Veritas Cluster Server Administrator’s Guide for more information on
how to create a resource, bring the resource online, and link a resource.

To configure a virtual network name

1
2

Create a Lanman resource with the virtual server name.

Specify the attribute IPResName. The value of this attribute should be the IP
resource name of the service group.
Resource names are case- sensitive in VCS.

Create a dependency with the Lanman resource as the parent resource and
the IP resource as the child resource.

Enable the Lanman resource and bring it online. This will bring the virtual
network name online.



88 | Oracle Enterprise Manager 10g Grid Control with VCS
Configuring the listener for virtual network name

5 Create a dependency with the Oracle resource as the parent resource and the
Lanman resource as the child resource.

6 Remove the dependency between the Oracle resource and the IP resource.

Configuring the listener for virtual network name

Perform these steps on all the cluster nodes. Ensure that the service group is
online on the node on which you perform these steps.

To configure the listener for the virtual network name

1 Offline the listener service resource on the node.

2 Inthe listener.ora file, change the host name to the network name from the
Lanman resource that you created.
Replace
HOST=virtual_ IP address
with
HOST=network_name
The default location of the file listener.ora is
%SORACLE_HOME%\NETWORK\ADMIN\.

3 Remove the database entries in SID_LIST, if any.
4  Save and close the configuration.

5 Online the listener service resource on the node.

Configuring the database service for virtual network

name

Perform these steps to configure the database service for the virtual network
name.

To configure the database service for virtual network name

1 If the file "tnsnames.ora" does not contain entries for Database Service and
Network Name, then create these entries using the Net Configuration
Assistant. You must create these entries on all the cluster nodes.

2 Associate the database with the listener.

m  Ensure that the initialization parameter file contains the following
entries:

m SERVICE_NAMES (the name of the database service)
m INSTANCE NAME (the name of the database instance)
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Example SQL queries to ensure these entries:

show parameter INSTANCE_NAME
show parameter SERVICE_NAME

These parameters are created during installation or database creation.
Use one of the following ways to configure the new attribute
listener_alias:

Run the following SQL command:

SQL> ALTER SYSTEM SET
LOCAL_LISTENER=’<listener_alias>’ scope=spfile;

OR

Add the following entry to the initialization parameter file
(pfile/spfile):

LOCAL_LISTENER = <listener_alias>

Define the parameter listener_alias. If your Oracle configuration uses
the file tnsnames.ora, edit the file as instructed below. The default
location of tnsnames.ora is $ORACLE_HOMES \NETWORK \ ADMIN.

Add the following to tnsnames.ora file:

<listener_alias>=

(DESCRIPTION =
(ADDRESS=(Protocol=TCP)(HOST=virtual_name)(Port=default port))
)

The listener_alias parameter gets appended by the default domain name
specified in the file sqlnet.ora.

Offline, and then online, the listener service, and database service
resources.

Edit the initialization parameter file. For the dispatchers parameter, replace
the virtual IP address with virtual name for dispatchers. See pages 33 to 34
of the VCS 5.0 Database Agent for Oracle Configuration Guide for more
information.
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Configuring an additional Oracle management agent

Configure an additional Oracle Management Agent for the virtual server. Note
that this agent is in addition to the agent that you installed earlier. The agent
that you installed in “Installing the Oracle management agent” on page 86 is for
the physical node, and this agent is for the virtual host.

Perform these steps on all the nodes. Make sure that the Oracle service group is
online on the node on which you perform these steps.

To configure an additional Oracle Management Agent

1  Atthe command prompt, type the following commands:

C:\> cd [Management Agent home]/bin

C:\ [Management Agent home] /bin>emctl deploy agent
[-n WindowsServiceName]

AGENTSTATE_dir AGENTSTATE_hostname:port
DeployHostName:port

Where,

WindowsServiceName: the new service which is used for the HA of
additional management agent. (We will create a GenericService
resource for this later.)

AGENTSTATE_dir: a new directory

AGENTSTATE_hostname: virtual host name

port: a new port

DeployHostName: physical FQDN of the host

port: default port

Example:

C:\Oracle\product™\10.1.0\em_1\bin>emctl deploy agent -n
OraEm10gOneVCSHost E:\Oracle\product\10.1.0\em_1\vcshost\
veshost:1831 vesw2h283.vesnet.com:1830

2  Start the Management Agent service ("OraEm10gOneVCSHost" in the above
example) for the management agent and make sure it starts.

3 Stop the Management Agent service on this node.

4 Repeat steps 1 to 3 on the next node.

Adding the database to the OEM 10g Grid Control

Perform these steps to add the database to the OEM 10g Grid Control.
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To add the database to the OEM 10g Grid Control

1 Access the OEM Grid control using the following URL:
http://<EM server.domainName>:7777/em

2 Logon with user as sysman. The Enterprise Management Server will
discover the virtual network in its target host. You have to remove the
listener and the database for the physical node and add the listener and
database for the virtual network name.

3 Onthe Enterprise Manager console, click Targets and then click All Targets.

4  Choose the database for the physical node, and click Remove. Click Yes to
confirm the database removal. Remove the listener for the physical node in
a similar way.

5 On the Enterprise Manager console, click Targets and then click Databases.

6 Click Add. The Enterprise Management Server will prompt you to select a
host for which you want to add the database.

7  Choose the virtual network name and click Continue. The Enterprise
Manager will discover the targets on that machine. Check if the database
and listener names displayed are the ones that you wish to manage from the
Enterprise Management Server.

8 Under Databases, click on the tools icon (under Configure) &% to
configure the database.

9  Specify the Database name and the Monitor Password. This password is
later used when you login to the database to monitor it.

10 Click Next and follow the instructions to complete the database
configuration. After you configure the database successfully, the tools icon

will appear as e% .
e
-
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Making the additional agent highly available

Add a GenericService resource to make the additional agent highly available.

To make the additional agent highly available

1

Set the startup type for the additional agent service to Manual, on all the
nodes. You must do this before configuring GenericService resource.

Create a GenericService resource for the Oracle Management Agent service.
(This is the service for the additional agent that you created in “Configuring
an additional Oracle management agent” on page 90).

Specify the attributes DelayAfterOnline and DelayAfterOffline. Set the
value as 30 seconds.

Sometimes the GenericService resource may go into an unknown state. This
is because the Oracle agent service takes some time in coming up. The
workaround for this is to increase the attributes DelayAfterOnline and
DelayAfterOffline, or probe the resource after the Windows service has
started.

Create a dependency with the GenericService resource as the parent
resource and the Netlsnr resource as the child resource.

Enable the GenericService resource and bring it online.
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OracleSG-GenericService

!

Netlsnr-VCSLISTENER

v

Oracle-VCSDB

OracleSG-MountV

OracleSg-Lanman

A

OracleSG-VMDg

OracleSG-IP

OracleSG-NIC

Notes:

The sequence in which database and the additional management agent is
created is not critical as long as everything is configured with the virtual

Server.

The additional Oracle Management Agent service will not come online till
the network name (Lanman) is online on the same node.

The Oracle Management Agent (for the physical node) can be online on both
the nodes. It's only the additional Oracle Management Agent (for the virtual
server) that needs to be online on one of the two nodes as it depends on the
virtual network name. So that the host information is always available.
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m Failover time may increase after the Management Agent is added to the VCS
cluster group. After Oracle service group is failed over to the other node, the
Enterprise Manager agent service should be restarted on the Enterprise
Manager Server in order to connect to the database using Enterprise
Manager.
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